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Introduction

Purpose of Guide

This QuickBooks Guide covers QuickBooks integration with Tabs3 Software. It includes
information on setting up integration and how QuickBooks integrates with Tabs3 Billing.

Additional guides for separate software features are also available.

All guides are available on our website at:

www.Tabs3.com/support/docs.html

Knowledge Base

You may be referred to additional detailed information located in our Knowledge Base at:

support.tabs3.com

Additional Resources

A comprehensive list of all resources for Tabs3 Software can be found on page 48.
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Integration Overview

Tabs3 Billing can optionally integrate clients, costs, and payments with QuickBooks. Fees
and accounts receivable (A/R) do not integrate with QuickBooks.

Tabs3 Billing to QuickBooks

Integration from Tabs3 Billing to QuickBooks is
automatic. Whenever a client, cost, or payment
is added to Tabs3 Billing, a corresponding
customer, job, or bill is automatically added to
QuickBooks (provided the client or tcode is
configured to integrate with QuickBooks).
Journal entries are automatically created in
QuickBooks for costs and payments in Tabs3
Billing.

QuickBooks to Tabs3 Billing

Integration from QuickBooks to Tabs3 Billing is
performed on demand. Running the Merge
QuickBooks Data with Tabs3 utility in Tabs3
Billing transfers all new or changed clients and
bill (cost) entries in QuickBooks to Tabs3
Billing.

The figure to the right provides an overview of
what data integrates between Tabs3 Billing
and QuickBooks.

For more detailed information on what does
and does not integrate, see the How Tabs3
Billing Integrates with QuickBooks section of
this Guide (page 29). For best practices when
integrating Tabs3 Billing and QuickBooks, see
the Best Practices section of this Guide (page
42).
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Costs / Bills
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Change Mo v
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Costs / Bill Journal Entries
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Payments /
General Journal Entries
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Delete ot Mo
orRetund | ¥ | Ne

** Existing journal Entries cannot be
deleted or changed. Adjusting Joumal
Entries will be oreated when changing or
deleting a WIP payment.

Figure 1, Integration Overview
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Terminology Differences

The terminology between Tabs3 Billing and QuickBooks differs for certain fields. The
following table shows the Tabs3 Billing field name and the associated QuickBooks field
name.

Tabs3 Billing QuickBooks
Client Name Customer Name
Work Description Job Name
Client ID Account No.
Timekeeper Sales Rep

Cost Bill

Credit Credit Memo

Billing Category Desc Job Type
Tcode Class

For a complete listing of field mappings between Tabs3 Billing and QuickBooks, including
screenshots, see the Field Mapping Between Tabs3 Billing and QuickBooks section of
this Guide (page 57).

Version Compatibility

Tabs3 Billing integrates with versions of QuickBooks Pro, QuickBooks Premier, and
QuickBooks Enterprise that are currently supported by Intuit. Tabs3 Billing does not
integrate with QuickBooks Simple Start or QuickBooks Online.

Tip: For more information on the versions that are supported, including which versions
of QuickBooks were tested with Tabs3 Billing and any issues, visit Knowledge Base
Article R11950, “Third Party Integration Requirements."

In order for integration to occur, every computer on which clients, costs, and payments
are added, edited, or deleted must be able to access the QuickBooks company file. This
can be accomplished via the installed QuickBooks application or via the QuickBooks
RDS application (page 47).
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Integration Configuration

Before Tabs3 Billing and QuickBooks can integrate, certain settings must be specified in
both Tabs3 Billing and QuickBooks. It is recommended to back up your data before
beginning. Tabs3 Software and QuickBooks backups must be made at the same time. If
you restore a backup of one system and not the other, your data may become
mismatched.

Multi-user Mode vs. Single-user Mode in
QuickBooks

In order for Tabs3 Billing to access QuickBooks, QuickBooks must be running in Multi-
user mode. By default, QuickBooks is configured to run in Single-user mode.

» Switching to Multi-user mode

1. In QuickBooks, from the File menu, select Switch to Multi-user Mode.
2. Ifa"Create New Users” window is displayed, click No.

3. Ifamessage is displayed indicating that the file can now be used in Multi-user
mode, click OK.

QuickBooks Multi-user Mode Limitations

When running QuickBooks in Multi-user mode, certain activities cannot be performed in
QuickBooks. If you need to perform an activity that can only be performed when
QuickBooks is in Single-user mode, you must first close Tabs3 Billing. Then, before Tabs3
Billing and QuickBooks can integrate again, QuickBooks must be switched back to Multi-
user mode. The following is a list of activities that can only be performed in Single-user
mode.

Note: This list was provided by QuickBooks and is subject to change.

« Backing up, condensing, converting, rebuilding, restoring, or updating the
company data file.

« Changing company information, including the closing date.
« Setting up or changing company preferences.

« Importing or exporting data.
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» Merging, deleting, or restoring list items.

« Changing list item fields that interact with other lists.
« Signing up for QuickBooks Payroll Service.
 Printing Form 1099-MISC.

» Mapping a network drive from within QuickBooks.

« Defining custom fields.

« Linking to QuickBooks from TurboTax.

o Accountant’s review activities.

» Switching to Single-user mode

1. In QuickBooks, from the File menu, select Switch to Single-user Mode.

2. Ifamessage is displayed indicating that the company file cannot be closed
because Tabs3 Billing is using it, click OK. Close Tabs3 Billing and repeat step 1.

3. A message will be displayed indicating that the file can now be used in Single-user
mode. Click OK.

4. Perform the desired task that requires Single-user mode.

Before using Tabs3 Billing again, switch back to Multi-user mode.

QuickBooks Application Certificate

The first time Tabs3 Billing attempts to pass data to QuickBooks, the user will see that a
certified application (Figure 2), Tabs3 Billing Software from Software Technology, is
requesting access to a QuickBooks data file.

« Select "Yes, always; allow access even if QuickBooks is not running”. In the Login
as field, select the desired user. (Note: This option is only available if multiple users are
set up in QuickBooks). Then click the Continue button.

« You will then receive a QuickBooks Access Confirmation window (Figure 3). Click
the Done button to complete the request.

Likewise, the first time Tabs3 Accounts Payable (AP), or PracticeMaster attempts to pass
Tabs3 Billing data (e.g., clients or costs) to QuickBooks, the user will see that a certified
application with the application’s name on it is requesting access to a QuickBooks data
file.

-10 -
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Note: AP and PracticeMaster do not integrate with QuickBooks. Instead, each of these
applications passes the requested data to QuickBooks via Tabs3 Billing. For more
information on how integration occurs with PracticeMaster, Trust, AP, GL, and more,
see the How Other Tabs3 Software Integrates with QuickBooks section (page 43).

Tip: For more information on Tabs3 Software Digital Certificates, visit Knowledge Base
Article R10905, “Authenticode Digital Certificate."

- Application Certificate

An application is requesting access to the following QuickBooks company
file:

Jensen, Martin & Anderson, P.C.
Access may include reading and modifying QuickBooks data as well as
enhancing the QuickBooks userinterface.

THE APPLICATION CALLS ITSELF
Tabs3 Billing Software

CERTIFICATE INFORMATION

Description:

Developer: Software Technology, Inc.

Developer identity has been verified by:
COMODO Code Signing CAZ

QUICKBOOKS SOLUTION S MARKETPLACE
# Learn about applications that integrate with QuickBooks

Do you want to allow this application to read and modify this company file?
7 Mo

T Yes, prompt each time

T Yes, whenever this QuickBooks company file is open

® iYes, always; allow access even If QuickBooks Is not running:

Loginas:  Admin -

Allow this application to access personal data such as Social Security Numbers and
customer credit card information. Tell me more

Continue... Cancel Help

Figure 2, QuickBooks Application Certificate

-11-
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nfirmation

You have chosen to grantthe application
Tabs3 Billing Software

access to the QuickBooks company file
Jensen, Martin & Anderson, PC.

any time, even if QuickBooks is not running.

Access rights:
- Read and modify QuickBooks data
(NOT including personal data)
- Enhance the QuickBooks user interface

If QuickBooks is notrunning, the application will log in as:
Admin

Done Go Back

Figure 3, Access Confirmation

-12 -
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Configuring Tabs3 Billing

In Tabs3 Billing, the following must be set up before integration can occur:

Customization
Clients
Transaction Codes

Sales Tax

Configuring Tabs3 Billing Customization

Integration with QuickBooks must be enabled in the Tabs3 Billing Customization window
before other integration setup can occur.

» Configuring QuickBooks Integration in Tabs3 Billing Customization

1.

v A WD

Determine the location of the company file you want to integrate with. An example
of a QuickBooks Company file is: \\server1\Program Files\Intuit\QuickBooks
Premier\Jensen.qbw. (Note: We recommend using a UNC path to avoid potential
problems with mapped drives when all computers do not use the same mapped drive
letter. When using a mapped drive, the mapped drive is seen form the perspective of the
workstation.) To locate your company file, perform the following steps.

a. In QuickBooks, press F2 or Ctrl+1.

b. In the File Information section (Figure 4), the Location field shows the path
of your Company file. Write this down.

Close the Product Information window and then the QuickBooks company file.
In the Tabs3 Billing Quick Launch, search for and select “Customization.” (Figure 5).
On the Other Systems tab, select QBXML Format for the Type of Integration.

If you want the Client ID shown after the description in the QuickBooks General
Journal Entry’'s Memo field, select the Append Client ID to QuickBooks General
Journal Entry Description check box.

In the Company File field, specify the location of the QuickBooks Company file
from step 1. The Browse button can be used to find the desired QuickBooks
Company file.

Press Ctrl+S.

-13-
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Product  QuickBooks: Premier Professional Services Edition 2016 Release R3P

License number 2317-8407-5380-373 ACTIVATED
Product number 167-745 R3_G2
UserLicenses 1

Installed 02182016

USAGE INFORMATION
Date FirstUsed  09/10/2012 Mumber of Uses 239
Audit Trail Enabled since 08/02/2011 12:36:50

FILE INFORMATION
Location C:Users\PubliciDocumentsintuitiQuickBooks\Company Files
‘Jensen, Martin & Anderson, P.C.QBW

Figure 4, QuickBooks Product Information

® Customization E=R{ESR =)

Main  ©Other Systems  Options Rates  Client Defaults Tabs3Pay LawPay LexCharge

General Ledger Software Integration

[Jintegrate with Tabs3 General Ledger

Trust Accounting Software Integration
Integrate with Tabs3 Trust Accounting TAS Serial #: 64000
Generate statements that only have a trust balance or remittance request

Include clients with only a trust balance on WIP reports

Practice Management Integration

Integrate Tabs3 Client Information with a Practice Management System

QuickBooks Integration
Type of Integration: QBXML Format Nz

[ Append Client ID to QuickBooks General Journal Entry Description

Company File: | C:\Users\Public\DocumentsiintuityQuickBooks\Company| | Browse

Figure 5, Tabs3 Billing Customization
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Configuring Tabs3 Billing Clients

When adding a new client in Tabs3 Billing that will integrate with QuickBooks, you must
first add a master client record with no Work Description. This master client record is also
referred to as a base client file record. After saving the master client record, you can then
add a matter (or job) for the client. The master client record and matter for the client
must have different Client IDs. For example, “808726.00" represents a master client record
that would be added first and “808726.01" represents a job or matter added afterward. If
this procedure is not followed, jobs may not be created in QuickBooks, or they may be
created improperly. If jobs are created improperly, further integration for those jobs may
not be possible. Keep in mind that adding a separate master client record only applies for
the first Matter for the client.

Note: If Tabs3 Billing clients are not already set up in this manner, one or more clients
in Tabs3 Billing must be renumbered before merging.

Tabs3 Billing clients must have a Client ID, Primary Timekeeper, and Billing Category that
match the Account No, Rep, and Job Type for the customer in QuickBooks.

« The Client ID field in Tabs3 Billing must match the Account No field in
QuickBooks.

« The Primary Reporting Timekeeper in Tabs3 Billing must match the Rep field in
QuickBooks.

« The Billing Category field in Tabs3 Billing must match the Job Type field in the
QuickBooks Job record.

Tip: For a complete listing of field mappings between Tabs3 Billing and QuickBooks,
including screenshots, see the Field Mapping Between Tabs3 Billing and
QuickBooks section of this Guide (page 57).

All clients are automatically set up to integrate with QuickBooks when Customization
settings are initially saved. However, you can individually change clients to not integrate
with QuickBooks (Figure 6).

» To disable integration for a client

1. Fromthe Tabs3 Billing Quick Launch, search for and select “Client Information.”

2. Select the desired Client ID.

-15-
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3. Fromthe Setup tab, clear the Integrate with QuickBooks check box.
4. Press Ctrl+S.

Client Information ’

Billing Options Billing Preferences Statement Cptions Split Billi
Address Setup Rates A/R & Fund Balances Client Notes

Cliert 1D: 850.00 W VWhite/Kely

Settings
Billing Categary: v Family Law

Billing Frequency: w Manthly Clients

Report Order Tmekeepers Status

Primary: o Kendra | Michasls [ Task Based Biling Client

Non-billabl
Secondary: w Michael L. Jensen [ | Nonbilzble
Originating: D w Robert O. Bums

Figure 6, Client Information, Setup tab

Configuring Tabs3 Billing Transaction Codes

In order for cost and payment transactions to integrate to QuickBooks, the transaction
must be saved with a transaction code (tcode) (Figure 7) and client configured to
integrate with QuickBooks. When configuring tcodes, keep the following in mind:

« Fees do not integrate with QuickBooks, therefore the QuickBooks integration
fields are not available for tcodes with a Transaction Type of Fee.

« Transaction codes with a Transaction Type of Expense or Advance create Bills and
Bill journal entries in QuickBooks. A default QuickBooks Debit Account can be
specified for the tcode. The QuickBooks Credit Account is always the Accounts
Payable account. Therefore, the QuickBooks Credit Acct field is not available.

« Payment transaction codes create general journal entries in QuickBooks. A default
QuickBooks Debit Acct and QuickBooks Credit Acct can be specified for payment
tcodes (e.g., Debit Undeposited Funds and Credit Income Account).

» The Tabs3 Billing Tcode Alpha Code field is used for integration instead of the
Tcode number. The Alpha Code is saved as a QuickBooks Class.

« Transaction codes with the following Type do not integrate with QuickBooks:
o FeeTcodes
o Type 4 - Description Only
o Type 6 - Progress Fee

-16 -
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» To configure cost and payment Tcodes in Tabs3 Billing

1. In QuickBooks, switch to multi-user mode.

2. Inthe Tabs3 Billing Quick Launch, search for and select “Transaction Code
Information.”

a.

f.

In the Tcode field, specify a tcode that you want to integrate with
QuickBooks.

In the Alpha Code field, enter a unique alpha code.
Select the Integrate with QuickBooks check box.
Specify a default QuickBooks Debit Acct.

Specify a default QuickBooks Credit Acct. This option is only available for
payments.

Press Ctrl+S.

3. Repeat step 3 for all tcodes you want to integrate with QuickBooks.

= Miscellaneous E@
Timekesper | Category | Tcode | Misc Desc | Bill Freq | Location | Task Code
Tcode: 100 W Alpha Code: MA
Type: 5 - Miscellaneous w Transaction Type: Advance W
Cost Type: | 0 - Miscellansous v

Description:  |[miscellaneous advance)

Spel

Bill Code 4 - Billable /* Aways Print v Charge Sales Tax

Amourt: 0.00 Effective Date of New Rate: \mm/ddAyyy | ¥
Rate: 0.000 New Rate: 0.000

Maove Rate
Integrate with Quick Books

QuickBooks Debit Acct: Advanced Client Costs v

Figure 7, Tabs3 Billing Tcode
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Configuring Tabs3 Billing for Assessing Sales Tax

Individual QuickBooks transactions do not contain sales tax. Therefore, in order for
transactions that are merged from QuickBooks to Tabs3 Billing to include sales tax, the
client and transaction code in Tabs3 Billing must be configured to assess sales tax.

To assess sales tax in Tabs3 Billing, the following must be configured:

» Tabs3 Billing Customization (Figure 8)

« Clients (Figure 9)

« Transaction Codes (Figure 10)

Tip: Additional information regarding sales tax can be found in KB Article R10952,
“Using Sales Tax in Tabs3 Billing."

» Tabs3 Billing Customization

1.
2.
3.

In the Tabs3 Billing Quick Launch, search for and select "Customization.”
Click the Rates tab.

In the Sales Tax section, select the check boxes for each type of transaction you
assess sales tax for.

Enter up to 9 different sales tax rates.
Press the Esc key to close Customization.

Click Yes to save the changes.

» Tabs3 Billing Clients

> won

5.
6.

In the Tabs3 Billing Quick Launch, search for and select “Client Information.”
Select the client you want to charge sales tax.
Click the Billing Options tab.

In the Sales Tax section, select the sales tax to be assessed for expenses and
advances.

Press Ctrl+S.

Repeat steps 2-5 for each client you want to charge sales tax.

Tip: Multiple clients can be configured at the same time using the Change Client
Options utility.

-18 -
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» Tabs3 Billing Transaction Codes

1. In the Tabs3 Billing Quick Launch, search for and select “Transaction Code

Information.”

Press Ctrl+S.

v A W

Select the tcode that you want to assess sales tax for.

Select the Charge Sales Tax check box.

Repeat steps 3-5 for each transaction code you want to assess sales tax for.

B Customization

[E=NEel &)

Client Defaults Tabs3Pay LawPay Lexcharge

Main  Other Systems Options Rates

Sales Tax
[ Tax services [ Tax Expenses [ Tax Advances
Rate1: | 50000 Rate2: | 6.0000] Rate 3:
Rate 4 | 0.0000] Rate5: | 0.0000] Rate &
Rate7: | 0.0000] Rates: | 0.0000] Rate &

Finance Charge

Figure 8, Customization, Rates tab

E Client Information

Address Setup Rates A/R & Fund Balances Cl
Billing Options Biling Preferences Statement Options
Cliert ID: w  Administrative Account

Fortracking all Firm and interest adjust
Threshold Biling kems

(@) Bill individual tem f its threshold is met Fes

() Bill all items i any threshold is met Eq

O Bil all tems f Total threshold is met Adv:
Courtesy Discount 1
Discount Type Amount ~ Amourt:

Change Discount Type to Mone after statement updated

Sales Tax

Fee: |2- 6.0000% ~ Eq: |2- 60000% ~| Adv: |2- 60000% ~

3
- Finance Charms, . )

Figure 9, Client Information, Billing Options tab

=N

Timekeeper Category Jcode Misc Desc Bil Freq Location Task Code

Alpha Code:

Transaction Type: Advance v

E Miscellaneous
Teode: W
Type: 5 - Miscellaneous ~
Cost Type: |0 - Miscellaneous ~
Description:  |[miscellaneous advance)
Spell
Bil Code: 4 - Billable / Always Print

b Charge Sales Tax

PR = BN =S

Figure 10, Tcode
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Configuring QuickBooks
In QuickBooks, the following must be set up before integration can occur:

o Customer
« Class Tracking
« Employee List

o Sales Tax

Verifying the Customer Account No, Rep, and Job Type

QuickBooks customers must have an Account No, Rep, and Job Type that match the
Client ID, Primary Timekeeper, and Billing Category in Tabs3 Billing. To verify that existing
customers have the correct Client ID, open the Customer Center in QuickBooks and verify
that the following fields match:

o The Account No field in QuickBooks must match the Client ID field in Tabs3
Billing.

o The Rep field in QuickBooks must match both the Name and Initials of the
Primary Reporting Timekeeper in Tabs3 Billing.

« The Rep field in QuickBooks cannot be the same as a Vendor in QuickBooks.

« Inthe QuickBooks Job record, the Job Type must match the Billing Category field
in Tabs3 Billing.

Tip: For a complete listing of field mappings between Tabs3 Billing and QuickBooks,
including screenshots, see the Field Mapping Between Tabs3 Billing and
QuickBooks section of this Guide (page 57).

When adding a new customer and job in QuickBooks, use the following guidelines:

o When adding a new customer, you must specify a Sales Rep (i.e., a valid Tabs3
Billing timekeeper) and an Account No. (i.e., a new Tabs3 Billing Client ID). Do not
fill out any information on the Job Info tab.

« After saving the customer, you must then add a separate job for the customer.
After adding the job, you must fill out the information on the Job Info tab and
specify an Account No. (located on the Payment Settings tab) that is different
from the account number for the customer. On the Job Info tab, you must specify
a Job Type (i.e., a valid Tabs3 Billing Category Description).

-20-
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Note: Customers and Jobs must have different Account Numbers. If this procedure is
not followed and the job has the same account number as the customer, the Job Type,
Job Name, and Start Date information will not pass from QuickBooks to Tabs3 Billing.
Additionally, if the customer and job have different addresses, contact names, phone
numbers, etc., when the Merge QuickBooks Data with Tabs3 utility is run, the job
information will be pulled into Tabs3 Billing and will also be posted to QuickBooks, thus
overwriting the QuickBooks customer information.

Setting Up Class Tracking

Cost transactions in Tabs3 Billing are assigned “tcodes”, which are equivalent to “classes”
in QuickBooks. Therefore, Class Tracking must be configured in QuickBooks if you want
to merge transactions from QuickBooks into Tabs3 Billing. Once Class Tracking is
enabled, a "Class” (i.e., tcode) can be assigned to a bill or time tracking record, which is
required for integration. For integration, QuickBooks Classes must be set up as the Tabs3
Billing Tcode Alpha Code field instead of the Tcode number.

» To configure Class Tracking in QuickBooks

1. In QuickBooks, switch to Single-user Mode.
In QuickBooks, from the Edit menu, select Preferences.
In the Preferences window, select Accounting from the list on the left (Figure 11).
. Click the Company Preferences tab.

. Select the Use class tracking for transactions check box.

2
3
4
5
6. Select Payroll & Employees from the list on the left (Figure 12).
7. When prompted to save, click Yes.
8. In the QuickBooks Payroll Features section, select Full Payroll.
9. For the Assign one class per option, select Earnings Item.
10

. Click OK.

Configuring the Employee List to Display by First Name

If you want clients in Tabs3 Billing to integrate with QuickBooks, the Employee List must
be configured to display by First Name.

-21-
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» To configure the Employee List to Display by First Name

1. In QuickBooks, switch to Single-user Mode.

In QuickBooks, from the Edit menu select Preferences.

Select Payroll & Employees from the list on the left (Figure 12).
Click the Company Preferences tab.

In the Display Employee List by section, select First Name.

Click OK.

o vk W

5% Accoutig 4 | MyPreferences  CompanyPreferences

B o ‘QUICKBOOKS PAYROLL FEATURES. SETPREFERENCES FOR

B comnar @ Eull payroll Pay Stub & Voucher Printing
B2 cnecing ™ Nopayroll

" Deskiop View
Finance Charge
B Accounting a MyPreferences | Company Preferences & oenera

B es ACCOUNTS 20 mteoratza appicatons

B colendar {Use aceount numbers @ R S tems & lnventory
B2 Checking E} Jobs & Estimates. Recall guantity field on paychecks  Recall hour field on paychecks

Workers Compensation

0 Online payrol Sick and Vacation

Copy earnings detais from preyious paycheck

E Hutiple Currencies. ¥ Job Costing, Class and Item tracking for paycheck expenses;

9 Desktop view
Tlass
Financs Charge B roymerts
= @ Use class tracking for transactions = e
@5 ceneral =" Payrol & Enphyess Assign one classper ) Entiepaycheck @ Eamings ftem

Prompt to assign classes

(0 Remnders

B nteorated Appications

Changing the employee

Figure 11, QuickBooks Accounting Figure 12, QuickBooks Payroll & Employees

Configuring QuickBooks for Assessing Sales Tax

Since sales tax is not assigned to individual Bills in QuickBooks, Tabs3 Billing sales tax
information cannot be sent to QuickBooks. However, if the client is set up for sales tax in
QuickBooks, all transactions for that client are considered taxable once they are placed
on a QuickBooks invoice or statement. This is true regardless of whether the Tabs3 Billing
transaction contained sales tax or not. Therefore, the following must be configured in
QuickBooks in order to assess sales tax in QuickBooks:

« Sales Tax Item (Figure 13)

« Customer (Figure 14)

» Sales Tax Item

1. In QuickBooks, switch to Single-user Mode.
In QuickBooks, from the Edit menu, select Preferences.

Fromthe list on the left, select Sales Tax.

> W

Click the Company Preferences tab.
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For the Do You Charge Sales Tax option, select Yes.

In the Set Up Sales Tax Item section, configure the necessary Sales Tax Items.
Specify any other sales tax preferences as desired.

Click OK.
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» Customer

1. From the Customers menu, select Customer Center.
Double-click the customer you want to assess sales tax for.
Click the Sales Tax Settings tab.

Specify a Tax Code and Tax Item.

v A~ W

If a customer is sometimes exempt from sales tax, enter the customer's tax
exemption ID in the Resale Number field.

6. Click OK.

7. Repeat steps 2-6 for all customers you want to assess sales tax for.

B Cotoncer A WyPreferences | Company Preferences
B# Checking Do you charge sales tax? @ Yes  No
"% Desiop view SETUP sALES X ITEM
Finance Charge Add a sales taxitem for each county, district, parish, etc. where you
& Gonern collectsales tax.  Show Examples Edit Customer
o Your most common sales taxiter i
2B ntegrated Appicatons
Add sales tax item. Lincoln NE Sales Tax -
M tens 2 vertoy
B some s Estmates cumREN sLCE
T Hutpie Currences ASSIGN SALES TAX CODES
B Payments Sales tax codes determine if he items you sell are taxable or non-taxable. Address Infa - |
Bl Payrol &Employees. Taxable tem code  Tax < | Nondaxapleitemcode o =
@ Rerind Esni=lEEEE Lincoln NE Sales Tax
@ Reminders =
. I 1dentiy taxable amounts as T~ for Taxable™ when printing
Reports & Graphs
all Rep o Sales Tax Settings N
R ensorosone sas v . ssnsvo. [Ezms] ]
5 . @ Month
® As ofinuoice date (Accrual Basis: ® Hanug Additional Info
- o Quarte

Figure 13, QuickBooks Sales Tax Figure 14, QuickBooks Customer

Note: When QuickBooks is configured to calculate sales tax, a Sales Tax Payable
account is created in QuickBooks. If you select this account for an expense or advance
transaction code in Tabs3 Billing, the error message “A/P detail line must have a
vendor” or “Sales Tax detail line must have vendor” will be displayed. To avoid this
message, do not select the Sales Tax Payable account when setting up transaction
codes to integrate with QuickBooks.
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Getting Started

Once Tabs3 Billing and QuickBooks have been configured for integration, you must
complete an initial integration.

Implementation Scenarios

The steps for your initial integration depend on whether there is pre-existing data

in Tabs3 Billing, QuickBooks, or both systems. If data exists in both systems, you must
complete all steps prior to running the Send Tabs3 Data to QuickBooks and Merge
QuickBooks Data with Tabs3 utilities.

Posting an Existing Tabs3 Billing Client Database to
QuickBooks

If you have been using Tabs3 Billing, and you want your current client database to be
posted to QuickBooks, you can use the following procedures:

» To send Tabs3 Billing data to QuickBooks

1. Make sure each Tabs3 Billing client matter has a base client. The client matter and
base client must have the same name with different Client IDs. You may need to
use the Renumber Clients utility to accomplish this.

2. Although Tabs3 Billing will add timekeepers to QuickBooks on the fly as required,
you may want to define all Tabs3 Billing timekeepers as employees in QuickBooks
in order to avoid potential issues with long names. If you add timekeepers in Tabs3
Billing, be sure to also designate them as sales reps in QuickBooks.

3. Run a Data File Integrity Check. Proceed only if there are no errors.
4. Make a backup of the Tabs3 Billing data files and the QuickBooks Company File.

5. If data does not exist in QuickBooks, run the Send Tabs3 Data to QuickBooks
utility.

Bringing over an Existing Customer:Job Database from
QuickBooks

If you have been using QuickBooks, and you want to bring over your current customer
database into Tabs3 Billing, you can use the following procedures:

-25-



QuickBooks Integration Guide

» To merge QuickBooks data with Tabs3 Billing

1.

®© N o v oA

Make sure each employee in QuickBooks has a corresponding timekeeper in Tabs3
Billing. Also make sure these employees are configured as sales reps in
QuickBooks.

Make sure each Tabs3 Billing Category Description has a corresponding valid Job
Type.
Make sure each customer has a job. Each customer and job in QuickBooks needs a

unique account number that is a valid Client ID in Tabs3 Billing. Customers and
jobs without a valid account number will not be passed to Tabs3 Billing.

Make sure each customer and job in QuickBooks is assigned a Sales Rep.

Make sure each customer and job in QuickBooks is assigned a valid Job Type.
Run a Data File Integrity Check. Proceed only if there are no errors.

Make a backup of the Tabs3 Billing data files and the QuickBooks Company File.

If data does not exist in Tabs3 Billing, run the Merge QuickBooks Data with Tabs3
utility to merge the QuickBooks information into Tabs3 Billing.

When Data Exists in both Tabs3 Billing and QuickBooks

If you have been using both Tabs3 Billing and QuickBooks, and you now want to
integrate the two systems, follow the steps for both scenarios above before running the
Send Tabs3 Data to QuickBooks and Merge QuickBooks with Tabs3 utilities.

Disabling Integration after Clients and Costs have Merged
from QuickBooks to Tabs3 Billing
If, after having successfully brought over all clients and costs from QuickBooks, you no

longer want to integrate with QuickBooks, simply disable the QuickBooks integration
setting in Tabs3 Billing Customization using the following procedures:

» To disable QuickBooks integration

1.
2.

In the Quick Launch, search for and select "Customization.”

On the Other Systems tab, in the QuickBooks Integration section, select a Type
of Integration of None.

Press Ctrl+S.
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Initial Integration

Menu: Maintenance | Integration | QuickBooks Integration
Home: All Actions | Integration | QuickBooks Integration
Quick Launch: QuickBooks Integration

Once Tabs3 Billing and QuickBooks have been set up to integrate, you must merge
preexisting data from one application to the other. This is accomplished via QuickBooks
Integration.

Type of Integration

The Type of Integration field provides two options: Merge QuickBooks Data with
Tabs3 (Figure 15) and Send Tabs3 Data to QuickBooks.

Merge QuickBooks Data with The Merge QuickBooks Data with Tabs3 option is
Tabs3 used to retrieve new QuickBooks information and
post it to Tabs3 Billing.

Send Tabs3 Data to The Send Tabs3 Data to QuickBooks option is

QuickBooks used to send Tabs3 Billing client and cost records to
QuickBooks. This utility will typically be used only
once since integration from Tabs3 Billing to
QuickBooks is automatic. This utility is provided
specifically for firms who have been using Tabs3
Billing and implement QuickBooks after the Tabs3
Billing data files have already been established.

Tabs3 File

The Tabs3 File field provides the option to merge/send All clients and costs, Clients only,
or Costs only.

It is recommended that the Send Tabs3 Data to QuickBooks utility be run for just clients
before costs are sent to QuickBooks. This is because Tabs3 Billing allows different
Client IDs to have the same name, however QuickBooks doesn’t allow two
Customers to have the same name. Furthermore, QuickBooks doesn’t allow a
Customer to have the same name as a QuickBooks Vendor, Employee, or name on
the Other Names List. If costs exist in Tabs3 Billing for both Clients, only transactions for
one of the clients will be sent to QuickBooks because only one client will get added to
QuickBooks. Running the Send Tabs3 Data to QuickBooks utility for only clients first will
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allow you to find out which clients have duplicate names before sending costs to
QuickBooks.

Merge Count

The merge count section provides the number of records for clients and for costs that
were added, changed, or were rejected due to errors.

Count The Count column indicates the total number of
records that were modified.

Add The Add column indicates the number of records
that were added.
Change The Change column indicates the number of

records that were changed.

Error The Error column indicates the number of errors
that were rejected due to errors.

Tip: Errors occurring during the Merge
QuickBooks Data with Tabs3 and Send Tabs3
Data to QuickBooks processes will be stored in a
file called STQBERR.LOG.

The OK button can be used to begin the merge process. This utility will verify the
information from QuickBooks before merging it with the main Tabs3 Billing data files.
During the merge process, various counts are displayed indicating how far along the
process is. Upon completion of the merge process, the message "Task Complete” will be
displayed.

The Cancel button will close the window without merging data. Once the merge process
has started, it cannot be aborted.
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QuickBooks Integration @
Type of Integration: IMerge QuickBooks Data with Tabs3 ']
Tabs3 File: All -

Last Merge: tderge has not been run
Court Add Change Error
Cliest
Costs:
[ oK ] I Cancel I I Help I

Figure 15, QuickBooks Integration window in Tabs3 Billing

How Tabs3 Billing Integrates with
QuickBooks

Integration from Tabs3 Billing to QuickBooks is automatic. Whenever a client or cost is
added to Tabs3 Billing, a corresponding customer or bill is automatically added to
QuickBooks (provided the client or tcode is configured to integrate with QuickBooks).
Journal entries are automatically created in QuickBooks for costs and payments in Tabs3
Billing.

How Clients, Costs, and Payments Integrate

The following discusses how clients, costs, and payments are integrated from Tabs3
Billing to QuickBooks.

For a complete listing of field mappings between Tabs3 Billing and QuickBooks, including
screenshots, see the Field Mapping Between Tabs3 Billing and QuickBooks section of
this Guide (page 57).

See the Best Practices section of the Guide (page 42) for recommendations on which
actions should be performed in Tabs3 Billing, QuickBooks, or both.

Clients

In order to integrate clients with QuickBooks, the Integrate with QuickBooks check box
must be selected on the Setup tab in the Client file. When clients are added, changed, or
deleted, the following will occur:
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Information is posted to QuickBooks automatically whenever a client is added in
Tabs3 Billing or an integrated field is changed in Tabs3 Billing (with a few field
exceptions as noted in the Field Mapping Between Tabs3 Billing and QuickBooks
section of this Guide [page 51]).

Deleting a client in either system will not delete the client in the other system.

Deleting a client in Tabs3 Billing will delete all of the fees and costs for that client in
Tabs3 Billing. However, the corresponding QuickBooks customer and its Bill
records will not be deleted.

Notes on Client Integration

If no Work Description is specified in Tabs3 Billing, a job is not created in
QuickBooks. Therefore no information is posted to the Job Type, Job Start Date,
and Job End Date fields in QuickBooks (even though there may be information in
these Tabs3 Billing fields).

When adding a client matter in Tabs3 Billing, in order for it to be passed to
QuickBooks as a job, the client must have the exact same Client Name contact as
the main client.

There are several fields that could integrate with Tabs3 Billing but are not
supported by Intuit's QBXML (such as the QuickBooks Mobile Phone field).

Changes made to the Date Opened, Date Closed, or Primary Timekeeper fields in
Tabs3 Billing will not be passed to QuickBooks.

Changing a client's name in Tabs3 Billing will create a new customer in
QuickBooks. The corresponding old QuickBooks customer is not affected. You
must change the customer’s name in QuickBooks before changing the client’s
name in Tabs3 Billing.

Client in Tabs3 Billing with the same client name and work description as an
existing customer in QuickBooks will not be added to QuickBooks.

Adding a client in Tabs3 Billing with the same client name as a QuickBooks Sales
Rep will generate the following error message and the customer will not be added
to QuickBooks: “The name XXXXXX of the list element is already in use.” Consider
changing the client contact’'s name in Tabs3 Billing slightly (e.g., by adding or
deleting a middle initial, etc., using the Rename Contact utility).

Tabs3 Billing will add a record to the QuickBooks Sales Rep and Job Type lookup
lists if the corresponding information specified in Tabs3 Billing does not already
exist in QuickBooks.
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« Although allowed in Tabs3 Billing, duplicate values in certain fields will cause
unpredictable results. Make sure you do not have duplicate values for the
following fields in Tabs3 Billing: Timekeeper Name, Timekeeper Initials, and
Category Description.

« Secure client information in Tabs3 Billing is passed to QuickBooks (provided the
Tabs3 Billing user has adequate rights). QuickBooks does not have secure clients,
so secure clients will move to QuickBooks and be viewable.

» The Tabs3 Billing Data File Integrity Check utility will generate errors for clients
with no name and employees with no initials. Addressing these issues helps
eliminate rejected records and duplicate employees.

« Clients marked as Inactive in Tabs3 Billing will move over to QuickBooks, but are
not marked as Inactive in QuickBooks. An Inactive client’s payments, costs and
fees will also move over from Tabs3 Billing to QuickBooks.

« Renumbering a client in Tabs3 Billing will renumber the Account Number in
QuickBooks.

« The Change Key Type utility will write all clients and matters to QuickBooks at one
time for clients that do not already exist in QuickBooks.

« QuickBooks does not allow colons in their Name fields. When you attempt to save
a record containing a colon in the Client Name, Timekeeper Name, or Category
Description files, the message “Invalid QuickBooks Name. Colon not allowed.” will
be displayed.

« Renumbering a category forces Tabs3 Billing to write all clients and matters to
QuickBooks at one time for clients assigned to that category that do not already
exist in QuickBooks. Changes are not made to the QuickBooks Job Type because it
is the category description that links the records, not the category number.

« Renumbering a timekeeper forces Tabs3 Billing to write all clients and matters to
QuickBooks at one time for clients assigned to that timekeeper that do not
already exist in QuickBooks. Changes are not made to the QuickBooks Sales Rep
because it is the timekeeper's initials and name that link the records, not the
timekeeper number.

Costs

When costs are added, changed, or deleted, the following will occur:
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« Inthe cost file, adds are supported both ways.

« Changes in Tabs3 Billing cost records are not passed to QuickBooks. However,
changes to Bills in QuickBooks are passed to Tabs3 Billing.

«» Deletions of cost records in either application will not delete the corresponding
cost in the other application.

« Deleting a client in Tabs3 Billing will delete all costs for the client in Tabs3 Billing,
but will not delete the Customer, or the corresponding Bills for the Customer, in
QuickBooks. The Bill in QuickBooks must also be deleted, voided, or placed on an
Invoice or Statement. Otherwise, the cost will be added back into Tabs3 Billing
when the Merge QuickBooks Data with Tabs3 Billing utility is run.

Tip: In order to integrate costs with QuickBooks, the Integrate with QuickBooks check
box must be selected on the Setup tab in the Client file and in the Transaction Code file
for the specified cost transaction code.

Additionally, after adding a cost transaction to Tabs3 Billing, detail journal entries are
posted directly into QuickBooks. The QuickBooks DB Acct field in the Cost file determines
the QuickBooks account which the Debit entry is posted to. A Default debit account can
be specified for each cost transaction code. The credit account is always the QuickBooks
Accounts Payable account.

In order to integrate costs with QuickBooks, Class Tracking must be enabled in
QuickBooks. This is required to work with Tabs3 Billing transaction codes.

Cost Credits

Entering a cost credit in Tabs3 Billing creates a Credit Memo in QuickBooks.

Notes on Cost Integration

« Ifthe client you are creating the cost for is configured to integrate with
QuickBooks (i.e., the Integrate with QuickBooks check box is selected on the
Setup tab in the Client file), the client must exist in QuickBooks. Otherwise an error
will be displayed while the cost transaction is being saved indicating an invalid
reference or argument was encountered. No information will be passed to
QuickBooks in this situation.

« Rich Text Format attributes (RTF - bold, italics, underline) are not supported by
QuickBooks; therefore these attributes are stripped before the description is
passed to QuickBooks.
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o When cost transactions are passed from Tabs3 Billing to QuickBooks, the Alpha
Code associated with the specified tcode is added to the QB Class List (if it is not
already present).

« When cost transactions are passed from Tabs3 Billing to QuickBooks, the Bill Due
in QuickBooks is ten days after the Date in Tabs3 Billing.

« Tabs3 Billing costs with an amount of "0.00" are passed to QuickBooks as a Paid
Bill.

« Allbillable Tabs3 Billing costs are passed to QuickBooks as billable (i.e., Bill Code =
“0" - Billable/Printable, “3" = Billable/Non-Printable, or “4" - Billable/Always Print).
Non-Billable Tabs3 Billing costs (i.e., “2" - Non-Billable/Printable, “3" - Billable/Non-
Printable) are passed to QuickBooks as non-billable.

» QuickBooks does not add sales tax to an entry until it is put on a Sales Form,
therefore Tabs3 Billing cannot send sales tax information to QuickBooks

Payment Entry

When a payment is entered into Tabs3 Billing, General Journal Entries are created in
QuickBooks; however, the actual payment is not integrated. For this reason, it is
recommended to only integrate payment transaction codes with QuickBooks if the actual
payments will not be entered directly into QuickBooks. If you enter a payment in
QuickBooks and create the QuickBooks General Journal Entries for Tabs3 Billing
payments, this would result in double posting. Saving a payment in Tabs3 Billing opens
the General Journal Entry Window.

General Journal Entry Window

Payment integration is based on a double-entry accounting system. For each Tabs3
Billing payment transaction that integrates with QuickBooks, you will need to post a
minimum of one debit and one credit via the QuickBooks General Journal Entry window
(Figure 16). Compound journal entries are allowed and there is no limit to the number of
debits and credits that can be posted for a single payment transaction. Each debit and
credit for the transaction is entered in the Journal Entry portion of the window. Default
QuickBooks debit and credit accounts can be specified for each cost and payment
transaction code. The Save Record button is then used to save the debit or credit to the
lower portion of the window. Once all debits and credits for the transaction have been
saved, the Save All button can be used to save the journal entry. Equal debits and credits
must be posted before the journal entry can be saved. (Note: You can save journal entries
for a portion of the transaction as long as the debits and credits are equal; however, this is
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typically not recommended since Tabs3 Billing will not be able to make adjusting entries in the
future if necessary.)

The Total and Remaining QuickBooks General Journal Entry *
amounts are shown at the top of Total Riemaining Save Al

. . . p. PetE o 20000 Debit 0.00
the window to assist with posting T Credit. 000 CiEs

. N BCK H __
the journal entry. The Total figure Balance: 0.00 il
J | Ent
represents the full amount of the A°“'”°"t iy Sae Rrooord
B TH . CCoUnt; R

Tabs3 Billing payment transaction. Delete Recard
This figure does not change. The ~ Peovtredt b Ameurt Concel
. . . o iption: [P t
figures in the Remaining column, =~ = 22 || o
including the Balance figure, are  —— P -

upd:?\t(.ad each time a debit or Operating Account ﬁ& Payment
credit is saved or deleted (and

also when the Apply Balance

button is used). When equal

debits and credits for the full

payment transaction amount

have been posted, the Remaining Figure 16, QuickBooks General Journal Entry Window
Debit, Remaining Credit and

Balance figures will all be set to

0.00 and you can use the Save All

button to save the journal entry

to QuickBooks.

Payment Adjustments

If you are integrating with QuickBooks and a QuickBooks journal entry was posted for
the original payment, an adjusting QuickBooks journal entry is created automatically
when a payment is reversed or refunded, provided both the transaction code and the
client are configured to integrate with QuickBooks. The process is performed without the
QuickBooks General Journal Entry window being displayed. The date of the adjusting
journal entry is the date of the original payment. Adjustments in QuickBooks are made
regardless of whether the period in QuickBooks has been closed.

Payment Reversal
Areversing journal entry is created for the QuickBooks journal entry associated with the
payment. For example, if the journal entry for the original payment was Debit Cash $300
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and Credit Fee Income $300, the reversing entry will be Credit Cash $300 and Debit Fee
Income $300.

Payment Refund

When a partial payment is adjusted, an adjusting journal entry is created for the
QuickBooks journal entry associated with the payment. For example, if the journal entry
for the original payment was Debit Cash $300 and Credit Fee Income $300, and $50 was
refunded, the adjusting entry will be Credit Cash $50 and Debit Fee Income $50.

Note: In the event a payment entry had multiple debits or credits, then the amounts for
the new journal entry is proportionately adjusted and any left over amount due to
rounding will be included with the last debit and/or credit account.

What Does Not Integrate

The following Tabs3 Billing items do not integrate with QuickBooks.

Fees

Fees entered in Tabs3 Billing, PracticeMaster, Tabs3 Connect, or Tabs3 Billing Remote do
not integrate with QuickBooks.

Archived Transactions

When a statement is updated in Tabs3 Billing, transactions are changed from work-in-
process to archived. The archived transactions do not integrate with QuickBooks; they
are neither added nor removed. Only work-in-process transactions will integrate with
QuickBooks, either upon saving the transaction, or when running the Send Data to
QuickBooks utility.

Accounts Receivable Balance

Since Tabs3 Billing does not integrate fees or archived transactions, and payments are
sent to QuickBooks as general journal entries, an accounts receivable balance cannot be
integrated.

Client Funds

Client Funds do not integrate with QuickBooks.
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Progress Billing Codes

Progress Billing transaction codes do not integrate with QuickBooks.

Write Offs

Although payment reversals and refunds integrate with QuickBooks, write offs do not.
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How QuickBooks Integrates with Tabs3
Billing

Integration from QuickBooks to Tabs3 Billing is performed on demand. Running the
Merge QuickBooks Data utility in Tabs3 Billing transfers all new or changed clients and
bill (cost) entries in QuickBooks to Tabs3 Billing.

How Clients and Costs Integrate

The following discusses how clients and costs are integrated from QuickBooks to Tabs3
Billing. For a complete listing of field mappings between Tabs3 Billing and QuickBooks,
including screenshots, see the Field Mapping Between Tabs3 Billing and QuickBooks
section of this Guide (page 51).

See the Best Practices section of the Guide (page 42) for recommendations on which
actions should be performed in Tabs3 Billing, QuickBooks, or both.

Clients

When clients are added, changed, or deleted, the following will occur:

o Whenever a customer or job is added in QuickBooks or an integrated client field is
changed in QuickBooks, the information will be posted to Tabs3 Billing the next
time the Merge QuickBooks Data with Tabs3 Billing utility is run.

« Deleting a customer|client in either system will not delete the client|customer in
the other system.

o Deleting a customer or job in QuickBooks does not delete the client in Tabs3
Billing. You must manually delete the client in Tabs3 Billing.

« Clients marked as Inactive in QuickBooks will not move over to Tabs3 Billing;
however, costs and fees will move over to Tabs3 Billing from an Inactive client in
QuickBooks.
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Costs

When costs are added, changed, or deleted, the following will occur:

« Inthe cost file, adds are supported both ways.

« Changes in Tabs3 Billing cost records are not passed to QuickBooks. However,
changes to Bills in QuickBooks are passed to Tabs3 Billing.

« Deletions of cost records in either application will not delete the corresponding
cost in the other application.

o Deleting a client in Tabs3 Billing will delete all costs for the client in Tabs3 Billing,
but will not delete the Customer, or the corresponding Bills for the Customer, in
QuickBooks. The Bill in QuickBooks must also be deleted, voided or placed on an
Invoice or Statement. Otherwise, the cost will be added back into Tabs3 Billing
when the Merge QuickBooks Data with Tabs3 Billing utility is run.

Credit Memos
Credit Memos are integrated with Tabs3 Billing as follows:

» Credit memos are passed to Tabs3 Billing as cost credit transactions if the “Qty”
field on the credit memo is blank.

« In QuickBooks, you can mark a Bill as a Credit. This type of credit transaction does
not get passed to Tabs3 Billing.

Note: Credit memos are typically not used when integrating with Tabs3 Billing because
accounts receivable is maintained in Tabs3 Billing.

Notes on Cost Integration

« QuickBooks classifies Bills, Checks, and Credit Card Transactions as Expenses or
[tems. Only Expenses are passed to Tabs3 Billing.

o There are two Memo fields in QuickBooks. The memo field directly under the
Bill/Credit Card area is not passed to Tabs3 Billing.

« Although QuickBooks does not require a customer/job to be entered for Bills,
Tabs3 Billing requires it. If a Bill is entered into QuickBooks without a
customer/job, no information will be passed to Tabs3 Billing when the Merge
QuickBooks Data with Tabs3 utility is run.

« Although QuickBooks does not require a Class (tcode) to be entered for Bills,
Tabs3 Billing requires it. If a Bill is entered into QuickBooks without a class, no
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information will be passed to Tabs3 Billing when the Merge QuickBooks Data with
Tabs3 utility is run.

« Bills, checks, and credit card transactions created in QuickBooks are passed to
Tabs3 Billing using the Tabs3 Billing client's primary timekeeper for the Timekeeper
field.

« The QuickBooks vendor is passed to the QuickBooks Vendor field in Tabs3 Billing.

o The QuickBooks account is passed to the QuickBooks Debit Account Field in Tabs3
Billing.

« Bills that are tagged as non-billable in QuickBooks are passed to Tabs3 Billing as
billable.

« Ifthe Bill Received check box is cleared, the Bill is considered an “Item receipt
Only". These transactions do not get passed to Tabs3 Billing.

« Cost transactions merged into Tabs3 Billing will have sales tax if the Client in Tabs3
Billing is set up to have sales tax on the Billing Options tab of the Client file and
the Charge Sales Tax check box is selected for the cost transaction code in the
Transaction Code file.

Reporting Data from QuickBooks

There are several reports in Tabs3 Billing that can be run to show transactions that were
merged from QuickBooks to Tabs3 Billing. Additionally, you can run a report to see which
tcodes have been set up to integrate with QuickBooks.

Detail Work-In-Process Report

Menu: Reports | Work-In-Process | Detail Work-In-Process Report
Home: All Actions | Reports | Work-In-Process Reports | Detail Work-In-Process Report
Quick Launch: Detail Work-In-Process Report

The Detail Work-In-Process Report can be set up to show which transactions came from
QuickBooks. The following option must be selected in order for QuickBooks information
to be displayed on the report:

« On the Format tab, you must select the Source check box. This option specifies
that the Src column be displayed on the report.
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When printing the Detail Work-In-Process Report with this option, any transactions that
came from QuickBooks will be indicated by a “Q" in the Src column.

Task Code Billing Report

Menu: Reports | Transactions | Task Code Billing Report
Home: All Actions | Reports | Transaction Report | Task Code Billing Report
Quick Launch: Task Code Billing Report

The Task Code Billing Report can be set up to show which task based billing transactions
came from QuickBooks. The following two options must be selected in order for
QuickBooks information to be displayed on the report:

« On the Options tab in the Source section, QuickBooks must be selected. This
option specifies that transactions originating in QuickBooks should be included
on the report.

« On the Format tab, you must select the Source check box. This option specifies
that the Src column be displayed on the report.

When printing the Task Code Billing Report with these options, any transactions that
came from QuickBooks will be indicated by a “Q" in the Src column.

Transaction Code List

Menu: Reports | Miscellaneous | Transaction Code List
Home: All Actions | Reports | File Lists | Transaction Code List
Quick Launch: Transaction Code List

When printing the Transaction Code List, each transaction code that integrates with
QuickBooks will be indicated by a "Y" in the QB column.

Transaction File List

Menu: Reports | Transactions | Transaction File List
Home: All Actions | Reports | Transaction Report | Transaction File List
Quick Launch: Transaction File List
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The Transaction File List can be set up to show which transactions came from
QuickBooks. The following two options must be selected in order for QuickBooks
information to be displayed on the report:

« On the Options tab in the Source section, QuickBooks must be selected. This
option specifies that transactions originating in QuickBooks should be included
on the report.

« On the Format tab, you must select the Source check box. This option specifies
that the Src column be displayed on the report.

When printing the Transaction File List with these options, any transactions that came
from QuickBooks will be indicated by a “Q" in the Src column.

Verification Lists

When printing a Cost Verification List, any cost transactions that came from QuickBooks
will be indicated by a “Q" in the Src column.
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Best Practices

As aresult of the different ways that the QuickBooks and Tabs3 Billing data files use key
fields, there is a difference in how changes and deletions are handled. Changes made in
QuickBooks are brought over to Tabs3 Billing; however, changes made in Tabs3 Billing
are not posted to QuickBooks. Conversely, deletions made in QuickBooks are not
brought over to Tabs3 Billing.

The following table includes the recommended system to use for the various integrated

tasks.

Function

Adding or Changing Clients

Deleting Clients

Adding Costs
Changing Costs

Deleting Costs

Deleting Payments

Recommended System
Either System
Required in Both Systems

Either System
QuickBooks

Required in Both Systems

Tabs3 Billing

Why

Integration works both ways.

Deleting a client in Tabs3 Billing will
delete the client as well as all
transactions in Tabs3 Billing, but neither
the Customer, nor Bills for the Customer
will be deleted in QuickBooks.

Deleting a Customer in QuickBooks will
not remove any transactions from Tabs3
Billing and will not delete the Client.
Integration works both ways.

Changing a transaction in Tabs3 Billing
does not change the transaction in
QuickBooks.

Deleting a cost transaction in Tabs3
Billing will not delete the corresponding
Bill record from QuickBooks.

Deleting a transaction in QuickBooks
does not delete the corresponding
transaction in Tabs3 Billing.

Deleting, reversing, or refunding a
payment in Tabs3 Billing will
automatically make reversing Journal
Entries in QuickBooks.
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How Other Tabs3 Software Integrates
with QuickBooks

The following provides information on how other Tabs3 Software integrates with
QuickBooks. It is important to understand that applications other than Tabs3 Billing do
not integrate with QuickBooks. Instead, Tabs3 Billing passes the requested data to
QuickBooks on behalf of these applications. Clients and Transaction Codes must be set
up in Tabs3 Billing to integrate with QuickBooks in order for other Tabs3 Software to
pass data from QuickBooks via Tabs3 Billing.

PracticeMaster

QuickBooks integration is not available with PracticeMaster only. However, QuickBooks
will integrate with PracticeMaster when Tabs3 Billing is installed. When Tabs3 Billing is
installed, clients and costs entered in PracticeMaster will integrate with QuickBooks.

Tabs3 Trust Accounting Software
Tabs3 Trust Accounting Software (Trust) integrates as follows:

« Payments to Firm from Trust do not integrate with QuickBooks. However, as a
work-around, opening a saved “Payment to Firm” from Trust in Tabs3 Billing and
saving the record again will then integrate the payment record with QuickBooks.

« Clients added in Trust will integrate to QuickBooks via Tabs3 Billing.

« Client information changed in Trust will integrate to QuickBooks via Tabs3 Billing.

Tabs3 Accounts Payable

Cost transactions for Tabs3 Billing are optionally created through Tabs3 Accounts
Payable (AP) when adding an invoice or manual check via the Cost Entry window. These
cost transactions will integrate with QuickBooks via Tabs3 Billing.

Tabs3 General Ledger

Tabs3 General Ledger (GL) integrates as follows:
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« Tabs3 Billing cannot be configured to integrate with QuickBooks and GL at the
same time.

« If APis configured to integrate with both Tabs3 Billing and GL, then saving an
invoice can do the following:

« Optionally create a cost in Tabs3 Billing, which will then create a QuickBooks
Bill and QuickBooks journal entries.

« Optionally create GL journal entries.

Tabs3 Connect

Cost transactions added via Tabs3 Connect do not integrate directly with QuickBooks.
Instead, the Send Tabs3 Data to QuickBooks utility can be used to periodically send
these costs to QuickBooks.

Cost Recovery Software

Cost transactions merged into Tabs3 Billing using the "“Merge Data Capture
Transactions” utility will integrate to QuickBooks with a vendor of STI-Vendor. The debit
account will be the account specified in the Transaction Code file. If no debit account is
configured for the transaction code, the STI-Expense account will be used. QuickBooks
must be open when the “Merge Data Capture Transactions” utility is run.

Tabs3 Billing Remote

Cost transactions merged into Tabs3 Billing using the "Merge Tabs3 Remote Data” utility
will integrate with QuickBooks as follows.

« When entering costs in Tabs3 Billing Remote, you can specify a QuickBooks
Vendor. Any vendor can be entered (there is no drop-down list to select one). If
you specify a vendor that does not already exist in QuickBooks, that vendor will be
added to QuickBooks. If no vendor is specified, the STI-Vendor will be the
QuickBooks vendor when the information is merged.

« Tabs3 Billing Remote does not have a QuickBooks Debit Account field. Therefore,
the debit account will be the account specified in the Transaction Code file. If no
debit account is configured for the transaction code, the STI-Expense account will
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be used.

« QuickBooks must be open when the Merge Tabs3 Remote Data utility is run.

Note: Remote validation files do NOT contain QuickBooks information. Integration
occurs through Merge Tabs3 Remote Data.
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Technical Considerations

When integrating Tabs3 Billing with QuickBooks, keep the following in mind.

Renaming Contacts

Renaming the client contact name in Tabs3 Billing does not change the name of the
existing QuickBooks customer. Instead, a new customer is added to QuickBooks.

Undo Updated Statement(s)

When running the Undo Single Updated Statements or Undo Multiple Updated
Statements utilities in Tabs3 Billing, integration with QuickBooks occurs as follows:

Original statement was Cost transactions are never deleted from
updated when configured for QuickBooks. Therefore, cost transactions do NOT
integration integrate to QuickBooks a second time when the

statement is undone.

Journal Entries are not affected by Undo Updated
Statements in Tabs3 Billing.

Credits do NOT sync to QuickBooks a second time
when the statement is undone.

Original statement was If the client is set up to integrate with QuickBooks,
updated prior to turning on and the client exists in QuickBooks, integration with
integration QuickBooks occurs as follows:

Transactions will integrate to QuickBooks if the
transaction code assigned to the transaction is
currently set up to integrate with QuickBooks. Cost
transactions will be assigned to STI-Vendor.

Journal entries will be created for cost transactions.
The QuickBooks debit account will be the account
specified for the transaction code. If the transaction
code does not have a default debit account, the STI-
Expense account will be the debit.
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Payment transactions will NOT create new Journal
Entries in QuickBooks.

Backing Up Data

Tabs3 Billing and QuickBooks backups must be made at the same time. |f you restore a
backup of one system and not the other, your data may become mismatched.

QuickBooks Remote Data Sharing (RDS)

In order for Tabs3 Billing to integrate with QuickBooks, QuickBooks must be installed on
each computer on which Tabs3 Billing is also used. Alternatively, Tabs3 Software users
can pass information to the QuickBooks data files without having QuickBooks installed
by using the QuickBooks Remote Data Sharing (RDS) software.

Tip: For information on installation, configuration, and troubleshooting for
QuickBooks RDS, see Knowledge Base Article R10884, "QuickBooks Remote Data
Sharing."

Troubleshooting QuickBooks Integration

When integrating with QuickBooks, various messages can be displayed. Knowledge Base
Article R10883, “Troubleshooting QuickBooks Integration,” includes an alphabetical list
of these messages and the steps necessary to troubleshoot.

Tip: If you are looking for a specific message in the article, press Ctrl+F and search for a
portion of the message.

Tip: Errors occurring during the Merge QuickBooks Data with Tabs3 and Send Tabs3
Data to QuickBooks processes will be stored in a file called STQBERR.LOG.
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Resources

Additional information on the features included in this guide is available via Tabs3
Billing's built-in help files and the Tabs3 Software Knowledge Base.

Help

Help is installed with the software and is easily accessed by pressing F1, by clicking the (7]
button, or in the Quick Launch by searching for and selecting “Help Topics.” Help includes

detailed information regarding specific applications and features. Clicking the (7] button
opens the relevant Help topic for the window you are currently using. Many times,
reading the appropriate Help topic may be the fastest way to find your answer.

Knowledge Base

Our Knowledge Base can be accessed 24 hours a day, 7 days a week. You can access the
Knowledge Base in the Quick Launch by searching for and selecting “Knowledge Base.”

« R11591, "QuickBooks FAQ,” contains frequently asked questions about the
integration between Tabs3 Billing and QuickBooks.

» R10884. "QuickBooks Remote Data Sharing,” includes installation, configuration,
and troubleshooting for QuickBooks RDS.

« R10883. "Troubleshooting QuickBooks Integration,” includes messages that may
be displayed when using QuickBooks. The messages are listed in alphabetical
order.

« R11950. “Third Party Integration Requirements,” provides an overview of the
specific versions and releases of third party applications currently tested and
supported that integrate with or convert to Tabs3 Software.

« R10905. “Authenticode Digital Certificate,” provides information on the benefits
of digital certificates and how they work.

« R11594. "Overview of QuickBooks Integration”

All Knowledge Base Articles are available on our website at:

support.Tabs3.com

-48 -


https://support.tabs3.com/main/r11591.htm
https://support.tabs3.com/main/r10884.htm
https://support.tabs3.com/main/r10883.htm
https://support.tabs3.com/main/r11950.htm
https://support.tabs3.com/main/r10905.htm
https://support.tabs3.com/main/R11594.htm
https://support.tabs3.com/

QuickBooks Integration Guide

Tabs3 Support

Tabs3 Software provides some of the best support in the industry. Service to our
customers is extremely important to us—so much so that our motto is:

Reliable software. Trusted service.

Support is provided at no charge with an active subscription and is available from 8:00
a.m. to 5:00 p.m. Central Time, Monday through Friday. If you have any questions, please
feel free to call our Support staff at (402) 419-2210.

Email support is also available for all firms with an active subscription. Our support team
responds to emails during office hours. Our goal is to respond to your question within
one business day. Please keep in mind that time-sensitive and complex issues are better
handled over the phone. To request email support, visit Tabs3.com/support.
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Field Mapping Between Tabs3 Billing and
QuickBooks

The following screenshots and tables depict the field mappings for the Client and Cost
files when configured for integration.

Client File Screenshots

The following screenshots depict the comparable field names between Tabs3 Billing and
QuickBooks.

E Client Information E@I
Billing Preferences Statement Options Split Billing Budget Client Portal
Address Setup Rates A/R & Fund Balances Client Notes Custom Fields Eilling Options

Client

Client ID: 850.01 | New inactive
Client Name: ‘ White/Kelly ‘ > Kelly White [ secure Client
Wark Description: ‘ Divorce (U5
Home* ~| | 201, 122nd Avenue East

Los Angeles CA 98507

Mame Search: White/Kelly Location: ~
Date Opened: 07/11/2024 ||~ Date Closed: | mm/dd/yyyy |~

Matter Contact

Contact Name: White/Kelly ~| Kelly White
: ~ | | 213-474-4336 f=} Home ~| | 323-489-3410 =

Email 1* ~ ‘ kelly@homeaoffice.net ||g,

Figure 17, Tabs3 Billing Client Name, Address, Phone, and Email
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= Edit

JOB NAME

CURRENT BALANCE 0.00

How do | adjust the current balance?

Ccusmwen White/Kelly v)

Address Info

Payment Settings

CETIIE

Additional Info

Main Phone ~  213-474-4336 Main Email =  kelly@homeoffice.net
Job Info

Alt. Phaone > | 1323-489-3410 CC Email -

Mobile - Website -

Fax v Other 1 -

ADDRESS DETAILS
IN T SHIF TO -
White/Kelly
201, 122nd Avenue East & +
Los Angeles, CA98507 Copy =»

Job is inactive @ Cancel Help

Figure 18, QuickBooks Customer, Phone, Email, and Address

= Client Information
Biling Options Biling Preferences Statement Options s}
Address Setup Rates A/R & Fund Balances Cli
Client
Client ID: 250.01 v
Ciient Name: [White/Kely | v Kely Arn Whie

‘Work Description:  Divorce

Home* | 201, 122nd Avenue East
Los Angeles CA 98507

et s g

Figure 19, Tabs3 Billing Work Description

= Client Information
Biling COptions Biling Preferences Statement Options 5}
Address Setup Rates A/R & Fund Balances Cli
Client

(Clent 1D: 850.01 L v
Client Name: White/Kelly v Kelly Ann White

Work Description: | Divorce

Home* v | 201, 122nd Avenue East
Los Angeles CA 98507

s g gl

Figure 21, Tabs3 Billing Client ID

Edit Job

JOB NAME

CURRENT BALANCE 0.00 How do | adjust the current balance?
Address Info

Payment Settings

Additional Info
MainPhone ~  213-474-4336

Job Info
Alt. Phone ~ | 322-489-3410

Mobile -

B i i

Figure 20, QuickBooks Job Name

Edit Job

JOB NAME

CURRENT BALANGE 0.00

How do | adjust the current balance?

Address Info
ACCOUNT NO.

Payment Settings

Additional Info

JobInfo

Figure 22, QuickBooks Account No.
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o] Client Information ! Edit Job
Biling Options Biling Preferences Statemert Options JoB Nave | Divorce
Address Setp Rates A/R & Fund Balances Cliert CURRENT BALANCE 0.00 How do | adjust the current balance?
Cliert 1D: 850.01 v E\fhrte/ i
Ivorce Address Info
Settings N
Billing Category- 35 v Family Law Payment Settings
Report Ordsr Timsksspers Status Jobinfo
Primary: 5 © Kendra |, Michaels [ Task Based Biling Client

Figure 23, Tabs3 Billing Primary Timekeeper Figure 24, QuickBooks Rep
Biling Options Biling Preferences Statement Options s{ o nave | Divorce
Address Setup Rates AR &Fwd Folmces et CURRENT BALANCE 0.00 How do | adjustthe current balance?
Client l

Address Info

Cliert ID: 850.01 v
Client Name: Wiite/Kelly v Kely Ann Vibite Payment Settings
Work Description:  Divorce 4
Additional Info
Home" v | 201, 122nd Avenue East ’ .
Los Angeles CA 98507

JobInfo

Name Search: |White/Kelly Location: |LA
@de@pened 07112024 | Date Closed: |mm/dd/y )

Matter Cortact

Figure 25, Tabs3 Billing Date Opened and Date Closed Figure 26, QuickBooks Start Date and End Date

E AL f
Billing Options Biling Prefersnces Statement Options S JOB NAME rce ‘
Set
Address up Rates A/R & Fund Balances Cliert CURRENT BALANCE 0,00 How do | adjust the current balance? {P
Cliert 1D 25001 v gvme/ Kelly
Ivorce Address Info '
Settirg: ] crieTion |
Biling Category: |35 v Family Law) Payment Settings
Billing Frequency: | Monthly w Monthly Clients Additional Info
Josswrus  None >
Report Order Timeksspers Status Job Info
Primayy: |5 v Kendra |. Michaels (] Task Based Biling Cient SERTDATE 071112024 M

Figure 27, Tabs3 Billing Category Figure 28, QuickBooks Job Type
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Fields in the Client File

Note: You can add or change clients/customers in either system. However, deleting a
Client/Customer in either system will not delete it in the other system.

The following table contains a complete listing of integrated fields in the client/customer
file. If a field is not listed, that field does not integrate between applications.

Tabs3 Billing
Name (Client) (50)
Figure 17

Desc (Work Description)
(50)
Figure 19

Addr1 (Selected Address,
Line 1) (35)
Figure 17

Addr2 (Selected Address,
Line 2) (35)

QuickBooks

Notes

Customer (Name)(41) | Changing the Tabs3 Billing client name does not change

Figure 18

Job Name (41)
Figure 20

Address (Line 2) (41)
Figure 18

Address (Line 3) (41)

the name of the existing QuickBooks customer. Instead, a
new customer is added to QuickBooks.

Changing the QuickBooks customer name does not
change the name of an existing Tabs3 Billing client.
Instead, an error will be produced when you attempt to
merge.

Clients with a blank name are not allowed in QuickBooks.

Client names can include any keyboardable character
except for a colon. QuickBooks does not allow the use of
colons in the Customer Name field.

Only integrates for Jobs.

If a Work Description is not specified in Tabs3 Billing, no
job is created in QuickBooks.

For its Address (Line 1) field, QuickBooks uses Tabs3
Billing's Client Name field.

Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.

Deleting an address line in either system will not delete
it in the other system.

Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.

Deleting an address line in either system will not delete
it in the other system.
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Tabs3 Billing

City (Selected Address)
(20)
Figure 17

State (Selected Address)
3)
Figure 17

Zip (Selected Address) (10)
Figure 17

Country (Selected
Address) (20)

Phone 1 (Business) (31)
Figure 17

Phone 2 (Home) (31)
Figure 17

Phone 3 (Business Fax) (31)

Email_Address (100)
Figure 17

Contact (Name) (50)
Figure 17

QuickBooks
City 31)
Figure 18

State/Province (21)
Figure 18

Zip/Postal Code (13)
Figure 18

Country/Region (31)

Phone (21)
Figure 18

Alt. Phone (21)
Figure 18

FAX (21)

Email (99)
Figure 18

Contact (41)
Figure 18

Notes
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
Changes are passed from Tabs3 Billing to QuickBooks.

Changes are not passed from QuickBooks to Tabs3
Billing.
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Tabs3 Billing
Primary Timekeeper
Initials (3) and Primary
Timekeeper Name (35)
Figure 23

Client_ID (13)
Figure 21

Date_Opened (10)
Figure 25

QuickBooks
Rep (5) and
QuickBooks Sales
Rep First Name (25)
Figure 24

Account Number (99)
Figure 22

Job Start Date (10)
Figure 26

Notes
Tabs3 Billing will add a lookup record to QuickBooks if a
matching record does not exist.

If the Tabs3 Billing timekeeper has no initials, the client
will not be added to QuickBooks.

Changes made in Tabs3 Billing are not passed to
QuickBooks.

Changes made in QuickBooks are passed to Tabs3 Billing,
but only updates the Primary Timekeeper field.

If no Sales Rep is specified in QuickBooks, the client will
not be added to Tabs3 Billing.

Sales Reps added through QuickBooks must exist as
timekeepers in Tabs3 Billing or the client will not be
added.

If no Account Number is specified in QuickBooks, the
client will not be added to Tabs3 Billing.

In order to integrate Jobs, both the Customer and the
Job must have an Account Number specified in
QuickBooks.

A numeric, alpha, or mixed key type can be used.
If no Work Description is specified in Tabs3 Billing, this
field is not passed to QuickBooks.

New Customers and Jobs added in QuickBooks without a
Job Start Date will merge into Tabs3 Billing with a Date
Opened of the current system date.

Changes made in Tabs3 Billing are not passed to
QuickBooks.

Changes made in QuickBooks are passed to Tabs3 Billing.
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Tabs3 Billing QuickBooks Notes
Date_Closed (10) Job End Date (10) If no Work Description is specified in Tabs3 Billing, this
Figure 25 Figure 26 field is not passed to QuickBooks.

New Customers and Jobs added in QuickBooks without a
Job End Date will merge into Tabs3 Billing with a Date
Closed of mm/dd/yyyy.

Changes made in Tabs3 Billing are not passed to
QuickBooks.

Changes made in QuickBooks are passed to Tabs3 Billing.

Billing Category Desc (30) |Job Type (31) Tabs3 Billing will add a lookup record to QuickBooks if a
Figure 27 Figure 28 matching record does not exist.

Jobs added through QuickBooks must be assigned a Job
Type that exists as a Tabs3 Billing Category.

If you create a Customer and a Job in QuickBooks and
want the same Category assigned to both, you must do
the following: Add the customer and assign a Job Type.
Then, add a Job and assign it the same Job Type.

Changes made in Tabs3 Billing are not passed to
QuickBooks.

Changes made in QuickBooks are passed to Tabs3 Billing.

Cost File Screenshots

The following screenshots depict the comparable field names between Tabs3 Billing and
QuickBooks.
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8 CostEnty E=En
BEE

Client 1D 850.01 = white Kelly @
Divorce

Reference: 2 - tanthiy Source:  Accounts Payable
Date: @ 0842042024 +  Tuesday Primary: 5 Kendra |l Michaels
Tcode:@ 109 = FF Nomal Advance

0.00 0.000 Amaourt: @ 150.00
Desciption:  |Filing fee (204] Clerk of the District Court - Slaiier dv Disodaiinr of ARamizms -
Timekeeper: ~ FRonald P. Anderson .UserID KEMDRA -
Bill Code: @U Billable / Printable v] @ Date Entered:  08/20/2024 =
R ate Code: 8 = Tcode Amount: 105.00 Status: Sales Tax:
QuickBooks Vendor: [5T14ender (5 ) ~| QuickBooks DB Aoct{STIExpense (6 ) -

— s

Figure 29, Tabs3 Billing Cost

Enter Bills
Main Reports How
@ Bil ) Credit | Bil Received
vencor [EEDEED (5) +| o @ 0812312024 B4
REF. NO
ADDRESS
150.00 @
BILL DUE 0B8/31/2024 E

Expenses $150.00 Items $0.00

STI-Expense 150.00 Filing fee (204) Clerk of the District. . White/Kelly:Divorce

Save & Close Revert

Figure 30, QuickBooks Bill

Fields in the Cost File

The following table contains a complete listing of integrated fields. If a field is not listed,
that field does not integrate between applications.
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Tabs3 Billing
1 | Client/Work Description

Date
Tcode
Bill Code

5 | QuickBooks Vendor

6 | QuickBooks DB Account

7 | Amount

Description (5000)
Date Entered

10 | User ID

QuickBooks
Customer Job

Date
Class
N/A

Vendor

Account

Amount

Memo (4095)
N/A

N/A

Notes
Valid entity required in order for transactions to be
passed.

Customer must have name, acct #, category (Job Type)
and timekeeper (Sales Rep).

Tabs3 Billing tcodes must have alpha codes.

Billable costs added in Tabs3 Billing are passed to
QuickBooks as billable.

Non-billable costs added in Tabs3 Billing are passed to
QuickBooks as non-billable.

Billable QuickBooks Bills are passed to Tabs3 Billing as
billable.

Non-billable QuickBooks Bills are passed to Tabs3
Billing as billable.

Note: In QuickBooks 2012 Premier and prior, non-
billable costs integrate from QuickBooks to Tabs3

Billing as non-billable.

Tabs3 Billing costs without a QuickBooks Vendor
assigned will be passed to QuickBooks with a vendor of
"STI-Vendor”.

Tabs3 Billing costs without a QuickBooks Account are
passed to QuickBooks with a Debit Account of “STI-
Expense” (regardless of whether it is a Tabs3 Billing
expense or advance).

The QuickBooks Credit Account is always Accounts
Payable.

Tabs3 Billing costs with 0.00 amount are passed to
QuickBooks as a Paid Bill.

RTF attributes stripped from QuickBooks.

The Date Entered field will be passed to Tabs3 Billing as
the date the Merge QuickBooks Data with Tabs3 Billing
is run.

The User ID field will be passed to Tabs3 Billing with
the User ID that ran the Merge QuickBooks Data with
Tabs3 Billing.
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Accounts Receivable Balances .__........ 35
Adding
clients 42
COSES ot 42
Adjustment of Payments _..........__... 34
Application Certificate ................... 10
Archived Transactions ..._............__. 35
B
BackingUpData ......................... 47
Backup
best practices ......_............ ... 9
Best Practices ............................ 42
adding costs ... ... 42
adding or changing clients .......... 42
changingcosts ...................... 42
deletingclients ..........__.......... 42
deletingcosts ......_................ 42
deleting payments _..........._...... 42
C
Certificate ........... ... 10
Changing
clients . 42
COSES ot 42
Class Tracking
settingup ...l 21
ClientFunds ... .. ..................... 35
Client Integration
in Tabs3 Billing ....................... 29
Tabs3 Billing integration notes __..... 30

Clients
configuring clients for integration _..15
disabling integration ___...__....._... 15
renaming contacts ................... 46
Configuring
classtracking ... ... ... ....... 21
Employee List ... ... ... ... 21
integration ... ... ... ... ..... 9
QuickBooks for integration ...__..... 20
QuickBooks to assess sales tax ....... 22
sales tax in QuickBooks .............. 22
sales tax in Tabs3 Billing _....._...... 18
Tabs3 Billing clients _...._....._...... 15
Tabs3 Billing for integration __...___. 13
transaction codes for integration .__.16
verifying customer information ...... 20
Cost Integration
in QuickBooks ... ... ....... 38
in Tabs3 Billing ..__................._. 31
Tabs3 Billing cost credits .__....__.... 32
Tabs3 Billingnotes . _................. 32
Cost Recovery Software
integration with QuickBooks ........ 44
Credit Memos in QuickBooks ... ........ 38
Customer Account Number
verifying ... ... 20
Customization Window
configuring for integration ...__..... 13
D
Deleting
clients ... ool 42
COSES e 42
payments ... .........iiiiiiiii.... 42
Differences in Terminology .............. 8
Disabling Integration .................... 26

-60 -



QuickBooks Integration Guide

E
Employee List in QuickBooks ............ 21
Error Messages ... ... ... ... 47

F
Fees o 35
Field Mapping ... ... ... ... ..... 51
client file screenshots _............... 51
cost file screenshots ... ........... 57
fields in the clientfile ... ........... 54
fields in the costfile .. .. .. .......... 58

G

General Journal Entry Window in

QuickBooks ... ... .. ... .. 33
General Ledger
integration with QuickBooks ......... 43
Getting Started ... ... ... ........ 25
H
Help ...l 48
How QuickBooks Integrates with Tabs3
Billing ... ... 37
How Tabs3 Billing Integrates with
QuickBooks ...... ... ... 29
|
Implementation Scenarios ............... 25

bringing QuickBooks information to 25

Tabs3 Billing ..................
data exists in both Tabs3 Billing and

QuickBooks .................. 26
disabling integration after data merge26
posting Tabs3 Billing database to

QuickBooks .................. 25
Inactive Clients _..........__..........._.. 31
Initial Integration .___............_........ 27
Merge Count ... ...........o........ 28
QuickBooks Application Certificate .. 10
Tabs3File ... . ... ... 27
Integration
Accounts Payable and QuickBooks ..43
best practices ..........._............ 42
cost recovery software and
QuickBooks .................. 44
items that do not integrate ..._....... 35
other Tabs3 Software applications
and QuickBooks .............. 43

PracticeMaster and QuickBooks ..... 43
Tabs3 Billing Remote and QuickBooks44

Tabs3 Connect and QuickBooks ... ... 44
Tabs3 General Ledger and
QuickBooks ..._....._........ 43
Trust Accounting and QuickBooks .. .43
Integration Configuration ..._............ 9
Integration Overview ... ... _..._....... 7
chart o . .. 7
QuickBooks to Tabs3 Billing ..._...... 7
Tabs3 Billing to QuickBooks .__...._.. 7
Integration Requirements ..._............ 8
J
Job Type
verifying ... ... 20
K
KnowledgeBase ....................... 6, 48

-61-



QuickBooks Integration Guide
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